
	User guidance
The standard form following is for the preparation of a tender document for Project Management Services
Part 3: Conditions of Agreement
Guide notes
This standard form contains guidance in hidden text, ie:
GUIDE NOTES;
Guide Note examples
Viewing guide notes
1. If the guide notes are not visible, click on the Show/Hide button [image: image1.bmp].
2. If still not visible, then:

•  At the Tools menu;

•  Click Options, and click the View tab;
•  Tick the Hidden Text check box and click the OK button.
Insertion points
Each ‘»’ shows where input is required. Click onto each ‘»’ and overtype.
When completed
1. Remove all guide notes manually or by the following steps:
•  On the Edit menu click Replace, then (if required) 
•  Click the More button;
•  Click the Format button, click on Font;
•  Tick the Hidden check box and click the OK button;
•  Click the Special button, click on Any Character; then
•  Click the Replace All button.
2. Delete this User guidance, along with the following Page Break.
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The Services
It is unlikely a project a manager will be engaged for all of the following phases. Delete any not applicable.

for the remaining phases review the following typical services then add and delete services to suit the engagement.

Scope of Services

1 General

.1 The Project Manager is responsible for the management of the Project to the Principal’s satisfaction.

.2 The Project Manager must:

.1 manage the Project on the Principal’s behalf;

.2 confirm at the outset and manage, coordinate and deliver the Project to meet the Principal’s strategic needs and Project objectives, any constraints or special needs, performance requirements, requirements for approvals and acceptable levels of service, the Project Budget and Project Program;

.3 plan, implement and manage Contracts for completion of specified activities or activities agreed with the Principal and production of specified deliverables within the agreed period and cost;

.4 follow procedures in applicable documents listed in the Appendices;

.5 take all necessary action to maintain overall progress in accordance with approved programs and budgets;

.6 prepare and present to the Principal, and when required by the Principal to stakeholders, reports seeking progressive endorsement of proposed Project outcomes;

.7 have all services under the Agreement, including services by subconsultants, carried out under a management system certified as meeting the requirements of AS/NZS ISO 9001:2000.

2 Project Program

.1 The Project Manager must:

.1 develop, refine and control an Approved Project Program (the Project Program or latest revision to the Project Program if approved) which:

(1) takes into account and shows Project timing and other relevant information contained in the Project Description,

(2) shows key Project activities and resource requirements,

(3) identifies all activities, including approvals and clearances and inputs required from the Principal and others, and highlights the critical milestones for each phase of the Project, 

(4) covers all Service Providers and any other relevant participants;

.2 submit to the Principal for approval when directed a description of any proposed revision to the Approved Project Program including reasons for the changes;

.3 provide to the Principal a hard and electronic copy of each Approved Project Program.

3 Project Budget

.1 The Project Manager must:

.1 develop, refine and control an Approved Project Budget (the Project Budget or latest revision to the Project Budget if approved) which:

(1) takes into account and shows relevant information contained in the Project Description,

(2) shows dissected estimates of the cost of key Project activities,

(3) covers all Service Providers and any other relevant participants;

.2 develop estimates of cost for the current phase, future phases and the Project as a whole consistent with the Approved Project Budget, and update these estimates as the need arises for a progressive estimate of final Project Cost;

.3 submit to the Principal a description of any proposed revision to the Approved Project Budget for approval, including reasons for the changes;

.4 provide to the Principal a copy of each Approved Project Budget;

.5 develop cash flow predictions consistent with the Approved Project Program and Approved Project Budget for the duration of the Project, and update the predictions at monthly intervals;

.6 not allow the Approved Project Budget  to be exceeded without prior approval of the Principal.

4 Project scope

.1 The Project Manager must:

.1 manage the potential for benefits and adverse impacts, and demonstrate the cost, time, fee and functional ramifications to enable informed decisions to be made on proposed variations and changes of scope;

.2 demonstrate to the Principal as required , and stakeholders as appropriate, the risk exposure including cost, time, fee and functional ramifications to the Project to enable informed decisions to be made including change directed or proposed by the Principal to Project scope;

.3 not change the scope of the Project without direction by the Principal including confirmation in writing of the Principal’s understanding of the ramifications;

.4 keep a record of the Principal’s approved changes to Project scope and associated revisions to the Approved Project Budget and Approved Project Program.

5 Services Delivery Plan

.1 The Project Manager must develop, document, implement and maintain a Services Delivery Plan that complies with AS/NZS ISO 9001 2000.  The Services Delivery Plan must cover at least:

.1 the Services as they relate to the Approved Project Program and Approved Project Budget;

.2 staged completion dates/ current forecast milestones,

.3 the anticipated Project completion date;

.4 scheduled Service Provider activities and the integration of their Contract Works;

.5 the deliverables required to satisfy the Agreement including provision for reviews and approvals, and reference to the associated records that are to be produced;

.6 the Fee component and reimbursable expenses for each phase of Services;

.7 a project organisation chart showing key personnel, and subconsultants and their relationships and major interfaces;

.8 key actions related to selection and management of Service Providers;

.9 regulatory requirements relevant to this Agreement including, but not limited to, building codes, standards, regulations, guideline and control documents, OHS procedures and design codes; 

.10 documentation management and control, including the reports and other documents to be prepared and delivered by Service Providers;

.11 design management;

.12 stakeholder communication, consultation and liaison;

.13 auditing and audit trails;

.14 reporting and monitoring;

.15 occupational health and safety in design and for work site activities.

.2 The Project Manager must provide the Services Delivery Plan within the time specified in Item 4 of the Agreement Information, or as otherwise agreed by the Principal to suit the progressive implementation of the Services Delivery Plan. The Services Delivery Plan may be prepared in stages, but the relevant parts of the Plan must be submitted, considered by the Principal (allow 7 days from receipt by the Principal), and in place before related services commence.

.3 With each Agreement payment claim the Project Manager must advise if the Services Delivery Plan has been revised and if so, submit details of the changes.

6 Liaison and co-ordination

.1 The Project Manager must:

.1 establish and maintain a Project team and maintain a record of its composition;

.2 represent the Principal as the single point of contact between the Principal and the Service Providers;

.3 identify, inform and involve approval authorities and stakeholders including affected organisations;

.4 manage the interface between the Principal, Service Providers, user groups and other stakeholders and approval authorities;

.5 manage the consultation process to ensure a comprehensive input by user groups and other stakeholders into the development of the Project;

.6 not incorporate into the Project requirements and requests raised by user groups and other stakeholders without the Principal’s approval;

.7 plan, brief, coordinate, direct, supervise and control the activities of Service Providers for satisfactory completion of the Project within the Approved Project Program and Approved Project Budget, and cash flow agreed with the Principal;

.8 secure all necessary approvals from the Principal and other agencies;

.9 bring issues that require consideration and/or decision by the Principal to the Principal’s attention as they arise, including options for their resolution which include the impact on the Project and its program, and recommend a course of action; 

.10 take all necessary action for and assist in effective and timely resolution of issues;

.11 prepare correspondence, reports and minutes relevant to the Project, including briefing notes to the Principal as necessary;

.12 prepare submissions, reports and briefing notes for other interested parties when instructed by the Principal.

7 Meetings

.1 The Project Manager must:

.1 develop Project meeting requirements in consultation with the Principal;

.2 attend or conduct as required project management committees and working parties including taking and issuing minutes and keeping other records;

.3 conduct Project coordination meetings with Service Providers, issue agendas, manage correspondence, chair, take and issue minutes as required; 

.4 advise the Principal of the dates of Project coordination meetings and workshops at least one week in advance;

.5 arrange and participate in workshops and meetings required under the Contracts;

.6 attend or conduct as required community liaison meetings including all planning, preparation and notices, management and support.

8 Reporting

.1 The Project Manager must:

.1 prepare and present to the Principal, and when required by the Principal to stakeholders, a written monthly Project Report addressing;

(1) Project status against the Approved Project Program;

(2) Services status against the Approved Project Program;

(3) Project Cost to Date compared with the Approved Project Budget;

(4) risk management issues status and recommended actions;

(5) the forecast effect of design changes on progress;

(6) updated anticipated cash flow;

(7) expenditure of contingency allowance;

(8) decisions affecting or likely to affect the Project;

(9) summary of delays claimed, recommended and/or approved in relation to the Agreement and the Contracts;

(10) summary of approved variations and claims;

(11) summary of potential variations and claims;

(12) industrial disputes affecting progress;

(13) photographs showing progress;

(14) any other significant matters, including potential claims, delays and disputes, with recommended action to keep the Project on time and budget;

.2 receive, review and incorporate into monthly reports to the Principal, progress reports from Service Providers.

9 Record keeping

.1 The Project Manager must in a systematic and organised manner:

.1 maintain accurate records of meetings, reports, financial monitoring data, drawings, specifications, briefs, approvals, work-as-executed records and test records related to the Services and Contract Works;

.2 take delivery and record the receipt of deliverables from Service Providers; 

.3 transfer and record the transmission of deliverables to the Principal; and

.4 retain a copy of all contract-related files for seven (7) years from completion of the Services or termination and make these accessible to the Principal on request.

10 Accounting and administrative procedures

.1 The Project Manager must follow the Principal’s accounting and administrative procedures set out under the Agreement and advised by the Principal.

11 Government policy and guidelines

.1 The Project Manager must:

.1 ensure inclusion of the requirements of relevant Government policy and guidelines in the Contracts and monitor the compliance of Service Providers, 

.2 comply with relevant Government guidelines,

.3 implement procedures and processes required under the NSW Government Procurement System for Construction including prequalification schemes for Service Providers, tendering systems, contract systems, performance reporting and dispute resolution;

.2 If the Project Manager has drawn non-compliance with Government policy and guidelines to a Service Provider’s attention and compliance has not been met within a reasonable time and the policy or guidelines require the matter to be reported, the Project Manager must advise the Principal of the non-compliance in writing, giving details.

12 Occupational Health and Safety management

mandatory if the services include management of design for construction or management of construction.

.1 The Project Manager must prepare and implement an OHS Management Plan (the Plan) for the Services, complying with the current NSW Government:

.1 Occupational Health & Safety Management Systems Guidelines; and

.2 Guidelines for Auditing Project OHS Management Plans.

.2 The Plan may be prepared in stages, but the relevant parts of the Plan must be submitted and in place before design or construction work commences.  

.3 The Outline OHS Management Plan provided with the Project Manager’s Tender must be incorporated into the Plan.

.4 The Plan must address statements of responsibilities, design and other consultant services, OHS induction and training, incident management, risk/hazard identification/assessment and control, consultation, Safe Work Method Statements and Site Safety Rules.

.5 The Project Manager must:

.1 manage the Services in accordance with the Plan;

.2 ensure that all participants in the Services are aware of and comply with OHS requirements;

.3 encourage a best practice occupational health and safety culture with carrying out the work under the Contracts, including with design, off site fabrication and construction generally;

.4 ensure the Plan is regularly audited internally and externally; 

.5 ensure the Service Providers’ OHS management plans are coordinated and consistent with the Plan;

.6 ensure OHS management plans prepared by the Service Providers and their subcontractors/suppliers and subconsultants are implemented and assessed for compliance with the relevant Contracts; and 

.7 manage the receipt of, and coordinate the Service Providers’ OHS management plans, and review, monitor, verify, audit and report on their implementation.

Management of Design

include the Above subheading and following paragraph and subparagraphs if the services include management of design.  Otherwise delete.

.6 The Project Manager, the Plan, and all OHS management plans relating to design must address the following requirements:

.1 ensure safety management in design is included in the designers’ OHS management plans;

.2 ensure all reasonably foreseeable hazards and risks to health and safety, both in the execution of the design, and in the subsequent use, maintenance, repair and demolition of the asset designed are identified, assessed, and where practicable, eliminated; and where it is not practicable to eliminate risks, to the degree practicable, effectively control the risks by design or by identifying operational requirements;

.3 in any review or assessment of risks that it is required to make, take into account, but not rely alone on, any hazard identification or risk assessment, elimination or control information provided to the Project Manager by the Principal; and not rely on the omission of any mention or detail of any hazard in the information provided by the Principal as evidence of the absence or limitation of any hazard; and

.4 include in the documentation all available information that is necessary to enable controllers of the designed premises or employers using the designed premises as a place of work, including but not limited to, Service Providers executing or constructing the asset designed, to fulfil their responsibilities with respect to identifying hazards, assessing risks arising from those hazards, eliminating or controlling those risks, and providing information.

End of paragraphs for management of design

Management of contract works on a work site

include the following and five sub-clauses 

include the Above subheading and following paragraph and subparagraphs if the services include management of contract works on a work site, including a site controlled by others.  Otherwise delete.

.7 The Project Manager must:

.1 ensure the Plan addresses the coordination, monitoring and verification of the Service Providers’ management of safety and security of the work sites with all the phases of the Contracts, including design and construction with transition to operation phases, and common site induction/security management;

.2 ensure the Service Providers implement management procedures for ensuring that design solutions allow safe methods of construction, maintenance, operation and use of the Contract Works;

.3 liaise with WorkCover regarding Contract Works issues and activities;

.4 plan and implement surveillance of the Service Providers’ safety management, including the monitoring of, and reporting on, all incidents and issues, and the actions taken by the Service Providers on these matters; and

.5 establish appropriate processes for monitoring and responding to potential safety risks and hazards associated with the Contracts.

End of paragraphs for Management of contract works on a work site

13 Risk management

.1 The Project Manager must:

.1 assess and manage Project risk as an integral part of the Services;

.2 in accordance with AS/NZS 4360:2004 or equivalent:

(1) prepare a risk management plan,

(2) identify at the start of each phase risks to the Project which require more detailed analysis,

(3) analyse and act on moderate risks,

(4) analyse and make recommendations to the Principal on major risks, and act on the Principal’s direction;

(5) monitor and report on the management and impacts of moderate and major risks;

.3 supply on request evidence of particular risk management processes.

14 Procurement strategy

.1 The Project Manager must assist the Principal to select the most appropriate project procurement system and develop the contract packages.

15 Engagement of Service Providers

.1 The Project Manager must:

.1 obtain approval from the Principal to every proposed Contract, its scope, and estimates of cost and time for completion;

.2 ensure that the engagement of Service Providers complies with the principles and procedures of the relevant documents listed in the Appendix: Instruments for the Services unless otherwise directed by the Principal;

.3 select panels of tenderers from pre-qualified panels in accordance with the NSW Government Procurement System for Construction;

.4 invite expressions of interest or arrange pre-registration when there is no suitable panel of tenderers;

.5 prepare tender documents complete and fully detailed in the form, nature and character of the relevant Contract, and ensure the tender documents have the commercial and contractual clauses required by the NSW Government Procurement System for Construction;

.6 manage the invitation and close of tenders; 

.7 evaluate tenders in consultation with the Principal and submit a tender evaluation report with recommendation for acceptance;

.8 prepare letters of award for issue by the Principal and issue letters to unsuccessful tenderers.

16 Management of Service Providers

.1 The Project Manager must:

.1 act as the person appointed to act on behalf of the Principal for each Contract as the Principal’s Authorised Person or Principal’s Representative in accordance with the NSW Government Procurement System for Construction procedures and authorities delegated by the Principal;

.2 manage Contracts in accordance with the principles and procedures required under the NSW Government Procurement System for Construction and as advised by the Principal;

.3 act as appropriate so that the Principal may satisfy its obligations under the Contracts;

.4 check that insurances are effected and maintained as required in the Contracts;

.5 review and assess Service Providers’ management plans and conduct quality management system audits; 

.6 respond promptly to requests for information from Service Providers, supply responses by written instruction, and keep records of the transactions;

.7 monitor the progress of specified activities and the production of specified deliverables to satisfy the Principal and relevant authorities, and to meet technical requirements of relevant codes, ordinances, regulations and standards;

.8 check that Service Providers have supplied certification of deliverables for compliance with the relevant specification, statutory requirements, and codes;

.9 manage the submission of all draft documentation supplied by Service Providers to the Principal for review and facilitate the approval process as follows:

(1) review draft documentation supplied by Service Providers and provide return comment;

(2) return documentation containing errors, or of inadequate quality or standard to the Service Provider for amendment;

(3) submit draft documentation of acceptable quality and standard, with comments, to the Principal for review;

(4) consolidate all review comments, on behalf of the Principal, and forward these to the Service Providers;

(5) review and comment on final documentation and submit to the Principal for approval only when it is of acceptable quality and standard;

.10 ensure that adequate inspection of Contract Work takes place in accordance with the Contracts;

.11 advise Service Providers of non-compliance with the Contract;

.12 examine and provide comment to Service Providers as appropriate on shop drawings;

.13 supervise the Service Providers to make sure that Contract Work is being carried out within contract conditions and to make sure that required quality standards are being met;

.14 inspect all samples supplied by Service Providers;

.15 require that any variation from acceptable standards be approved by the relevant Statutory Authorities before consideration for acceptance; 

.16 monitor Service Provider progress on a continuous basis;

.17 check and report to the Principal on the value of progress claims;

.18 make recommendations to the Principal as appropriate concerning certification of contractual outcomes;

.19 when in receipt of a payment claim:

(1) follow the Principal’s payment procedures,

(2) carry out all action required the ensure the Principal meets its obligations under the Contract;

.20 advise on options for, get approval to and take action on the mitigation of delays and resolution of issues;

.21 issue letters of determination to Service Providers regarding claims settlement as directed by the Principal;

.22 manage resolution of Contract disputes with Service Providers in accordance with the Principal’s requirements;

.23 report on Service Provider performance as required under the NSW Government Procurement System for Construction;

.24 refer to the Principal issues outside delegated authority.

17 Design

.1 The Project Manager must:

.1 review any design brief for all components of project, including the functional analysis and complete room data information;

.2 review site planning options for new works against the existing master planning for the Project, including definition of development options and preliminary budgets to include any recurrent cost implication;

.3 have users’ functional requirements that are approved by the Principal incorporated in the Project;

.4 review and develop the preferred design option as a concept plan and submit for approval;

.5 ensure architectural and engineering services documentation is co-ordinated;

.6 prepare a project implementation proposal for the preferred option providing a program, staging, cash flow and recommended procurement strategy;

.7 provide full scope of all engineering services required plus any essential upgrading;

.8 liaise with the Principal and Service Providers as necessary to generate a detailed cost plan of the total cost of the preferred option, including furniture, fittings and equipment, construction costs and consultant fees.

18 Construction

.1 The Project Manager must:

.1 manage all preliminary site activities, including relocations of affected persons, demolition, services relocations, excavation, archaeological requirements and any other activities prior to construction of the Contract Works;

the following sub-clause re principal contractor is mandatory.

.2 ensure there is one principal contractor among the Service Providers;

.3 attend and chair GC21 start-up workshops, all ongoing evaluation workshops and the close-out workshop;

.4 progressively check construction documents, working drawings, specifications and schedules;

.5 advise on materials tests and results;

.6 arrange for the Contract Works to be measured and valued, and provide appropriate checking and verification;

.7 manage a pro-active and comprehensive process to ensure Service Providers identify and make good all defects before completion of the Contract Works.

19 Commissioning and handover 

.1 The Project Manager must:

.1 coordinate the commissioning and finalisation of the Project, ensuring that all necessary performance tests and demonstrations on and commissioning of plant and equipment are carried out in preparation for handover to the Principal at Completion;

.2 forward to the Principal, prior to occupation or handover of the Contract Works, all as built drawings, operating and maintenance manuals, and relevant compliance certificates including BCA compliance;

.3 provide certification that the Contract Works are in accordance with all relevant authorities’ requirements and the design documentation;  

.4 list approved changes to the specification or design;  

.5 inspect all Contract Works prior to Completion in conjunction with representatives nominated by the Principal, prepare a list of defects and incomplete Contract Works and issue to the relevant Service Provider;

.6 inform the Principal when each Contract reaches completion; 

.7 ensure maintenance agreements are instituted in accordance with contractual requirements;

.8 prepare an Asset Maintenance Plan.

The Deliverables
It is unlikely a project a manager will be engaged for all of the following phases. Delete any not applicable.

for the remaining phases review the following typical services then add and delete services to suit the engagement.

Deliverables 

The Project Manager must supply to the Principal the following deliverables for the following phases.

in line with the scope of services above IT IS UNLIKELY THE PROJECT MANAGER WILL BE ENGAGED TO SUPPLY ALL OF THE FOLLOWING TYPICAL DELIVERABLES. DELETE those deliverables and phases for any phases NOT APPLICABLE.

of the remaining phases DELETE THOSE services NOT APPLICABLE AND ADD AS REQUIRED.

the list of deliverables hereunder must agree with the list in the schedule of prices if used.

20 Service demand identification

.1 Service outcomes strategy

.2 Asset Strategy plan

21 Service delivery options

.1 Service delivery options study 

.2 Feasibility analyses

.3 Preliminary risk identification and risk management schedule 

.4 Stakeholder identification

.5 Cross agency impact statement

22 Justification of proposed option

.1 Project Strategy Report

.2 Preliminary financial and economic appraisal

.3 Heritage impact study

.4 Traffic impact study

.5 Environmental impact study

.6 Preliminary risk assessment

.7 Preliminary project budget 

.8 Preliminary project program

23 Project definition

.1 Project Appraisal

.2 Feasibility Study Report 

.3 Economic Appraisal

.4 Financial Appraisal

.5 Value Management study report

.6 Risk management plan

.7 Project Budget

.8 Project Program

.9 Stakeholder views analysis

.10 Change management assessment

.11 Benefits realisation register

.12 Business Case submission

24 Procurement strategy

.1 Project procurement plan

.2 Advice on sourcing tenderers

.3 Updated risk management plan

.4 Change management plan

.5 Communication plan

.6 Project organisation chart & resource schedule

.7 Report on stakeholder support

.8 Procurement Strategy Report

.9 Project budget & cash flow

.10 Updated Project Program

25 Specification

.1 Geotechnical report

.2 Contamination report

.3 Hazardous materials report

.4 Dilapidation report

.5 Field survey

.6 Approvals from relevant authorities

.7 Tender documents

.8 Tender evaluation plan

.9 Pre-tender estimate

26 Service Provider Selection

.1 Tender evaluation, recommendation, approval

.2 Contract documents

.3 Completed tender award actions

.4 Post Tender Review Report confirming completion of contract award actions

27 Implementation

.1 Schematic design

.2 Design development

.3 Design documentation 

.4 Acceptance test reports

.5 Completed and verified asset

.6 Contract management records 

.7 Finalised Contracts

.8 Commissioning plans

.9 Asset management information

.10 Performance reports on Service Providers

28 Operation

.1 Operation plans

.2 Maintenance plans

.3 Maintenance records

29 Evaluation

.1 Report on benefits and level of service

.2 Report on Project Budget and Project Program

.3 Strategies for renewal or discontinuation of service

.4 Performance reports on Service Providers

.5 Post completion/implementation reports and reviews

.6 Benefits realisation report

Insert the Name of project and/or contract and theContract No.

The details must match those on the title page
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